WorldMap Help
Center for Geographic Analysis, Harvard

1.0 OVERVIEW

1.1 GETTING SUPPORT

1.2 TERMINOLOGY

2.0 VIEWING A MAP

2.1 FIND A MAP TO VIEW

2.2 NOTE ON PERMISSIONS

2.3 CHOICE OF BASEMAPS

2.4 WAYS TO ZOOM

2.5 FINDING PLACES USING THE GAZETTEER TOOL

2.6 LAYER ON/OFF, LAYER ORDER, TRANSPARENCY

2.7 LAYER RENAMING, CATEGORY RENAMING

2.8 TRANSPARENCY CONTROL

2.9 BOOKMARK AND EMBED YOUR MAP IN ANOTHER WEB PAGE

2.10 ANNOTATE A MAP

2.11 ADD EXTERNAL DATA (FEED)

2.12 TWEETMAP: A SPECIAL TYPE OF WORLDMAP MAP

2.13 MAP CLICK FOR DETAILS

2.14 SEARCHING WITHIN A LAYER

2.15 STREET VIEW

2.16 GOOGLE EARTH VIEW WITHIN BROWSER

2.17 LEGEND, SCALE BAR

2.18 DOWNLOADS

2.19 PRINTING

2.20 DOWNLOADING

2.21 REVISION HISTORY

3.0 CREATE YOUR OWN MAP

3.1 REGISTERING

3.2 FILLING IN YOUR PROFILE

3.3 CERTIFYING A MAP

3.4 RANK AND COMMENT ON A MAP

3.5 CREATE A MAP

3.6 CHANGE BASE MAP

3.7 SAVING YOUR MAP

3.8 PERMISSIONS, MAP NAME, PROFILE

4.0 ADDING LAYERS TO YOUR MAP

4.1 WORLDMAP DATA

4.2 ADDING EXTERNAL MAP SERVICES

4.3 UPLOAD LAYER

4.3.2 Upload GeoTIFF

4.3.3 Uploading a TIFF Created with ArcGIS

4.3.4 Permissions
1.0 Overview

This documentation refers to WorldMap Version 1.2. Though we are out of Beta, the system is still under rapid development with improvements planned to interface design, stability, and performance. Please send any comments or suggestions you might have to worldmap@harvard.edu.

WorldMap has been tested more thoroughly on Firefox and Chrome than on Internet Explorer, though it should work reasonably well with IE. There are known problems with Internet Explorer 6.

There are several areas of functionality that require you leave the main map page. When that happens, you will be asked whether you want to navigate away from the page. Click cancel, then save your map if desired, then proceed again. We hope to get this better implemented before long.

When you are away from the map page you have saved you can use the back button to get back to it.

Open System Access
The system is currently open to anyone in the world to use and is hosted by Harvard on Amazon’s cloud infrastructure. We are allowing anyone to upload fairly large files to the system (up to 100 meg). The combination of open access and large file sizes means that the system could be slow at times.

Open Source
The platform is Open Source and can be deployed on Linux or Windows environments. WorldMap is currently being developed and deployed on Ubuntu Linux. Because it is Open Source, all code in the system can be examined and improved on by others. Source code for WorldMap is available at: https://github.com/cga-harvard/cga-worldmap.

1.1 Getting Support

About WorldMap:  http://about.worldmap.harvard.edu

Getting started video:  available  http://www.youtube.com/watch?v=Ajctx6h1t5s

This Document:  http://worldmap.harvard.edu/site_media/docs/WorldMap_Help.pdf

User Group:
If you have a question that is not answered in this document, please check the Google Groups WorldMap users site  http://groups.google.com/group/worldmap-users and see if it has been answered there. If not please put your question to the WorldMap Users group.

Contact:
You can contact us at:  worldmap@harvard.edu.

1.2 Terminology

Layers
In WorldMap you can upload map data (currently Shapefiles or GeoTIFFs) to the system. Each data file you upload is called a “Layer” in WorldMap. You can control the way in which other people access to your layers by setting permissions for your layers.

Maps
WorldMap allows you to organize your Layers and other people’s Layers together into collections, which you can configure and save. We call these collections of Layers that you manage “Maps”. You can control permissions at both the Layer and the Map level.

2.0 Viewing a Map
WorldMap supports two basic uses of the system: 1) viewing (and if you are allowed, editing of Maps others have created, and 2) creating your own maps. We will start with viewing maps others have created.
2.1 **Find a Map to View**

To start searching existing maps, click “Viewing a Map” on the front page. Here you will see a list of maps others have created, listed in the order in which they were created. Use the search box to filter Maps by their title and abstract. Use the map to the right to refine your search geographically.

Next to the Map name is the name of the person who created it so you can contact them. WorldMap allows you to find out who added a particular Layer or created a Map and view their profile.

For example, click on Lex’s profile. Lex is building a map called ChinaMap. Lex has added a custom banner, which you can do too; just email one to us and we will add it to your map. Eventually you will be able to add it yourself.

2.2 **Note on Permissions**

Without being registered you can make changes to this Map but you can’t save the changes without permission to edit the map. You cannot be given permission to edit a map if you are not registered.

Currently this map (image below) is set to be viewable by anyone in the world. If you have permission to manage permissions for a map, a “Share Map” link will be visible at the upper right corner of the map view.

![Map Permissions](image)

*The “Share Map” link brings up Map permission controls*
### Overview of Map level permissions

<table>
<thead>
<tr>
<th>Permission Level</th>
<th>Can View a Map</th>
<th>Can Download a Layer</th>
<th>Can Edit a Style</th>
<th>Can Add/Remove a Layer</th>
<th>Can Change Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>View</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Edit</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Manage</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### 2.3 Choice of Basemaps

A number of preset basemap layers are available, including Google Satellite, Hybrid, Roads, Physical, and Open Street Maps. Other commercial and noncommercial base maps will be added soon.

### 2.4 Ways to Zoom

There are several ways you can zoom (change scales) in WorldMap:

- Map navigation tools include the standard zoom bar and map drag.
- Roll your mouse wheel.
- Choose a scale from the scale bar readout.
- Zoom and pan simultaneously by defining a box on the map (shift-drag box) which upon release zooms you to the area you defined with the box.
- You can right-click on a layer name and select “Zoom to Layer Extent” to zoom to that layer.

We highly recommend the shift-drag box approach as it is the most powerful way to navigate once you get the hang of it.

### 2.5 Finding Places Using the Gazetteer Tool

This tool allows one to find a location for many named places around the world. An optional temporal search parameter also allows one to find locations for historical place names. Since no gazetteer (place name database) is complete, this tool is configurable to search multiple gazetteers. The default gazetteer is Google Places but GeoNames, Yahoo, and WorldMap’s own gazetteer (which you can contribute to!) can be designated to be searched simultaneously.

To use the gazetteer tool:

1. Click on the Gazetteer button above the map.
2. Type in the desired place name and click “Search”. Select a result to see its location on the map.
3) Use the “Advanced” pulldown to select additional geocoders or gazetteers to search from.

4) With an additional gazetteer (in this case Geonames), try your search again. Geonames often returns many features which contain the name but represent different places, some of which may be close to one to one another geographically.

Adding Places to the WorldMap Gazetteer
Owners of WorldMap layers can submit their layers to the gazetteer if they would like to have their features show up in gazetteer search. To submit a layer for inclusion in the gazetteer, first go to the Layer page for the layer you wish to submit. To get to this page from the map:

1) Right click on the layer name in the list to the left of the map
2) Select “Layer Properties”
3) Click “About” tab
4) Click “Share Layer”
5) Once on the Layer page, look toward the bottom right of the page and find the “Manage Layer” section. Click “Update the description of this data”
6) In the metadata editing page, toward the bottom, within the “Attributes” control section you will see a check box for “Include in the gazetteer”. Check that box.
7) Click “Update” at the bottom of the page.

Gazetteer API
See information on the Gazetteer API in the Appendix

2.6 Layer on/off, Layer Order, Transparency
You can turn layers on and off and drag them around to control which layers are displayed on top in the map.

The drawing order of layers across different folders can become incorrect based on the creation of new folders. When that happens, one can drag the folders up and down to "re-enforce" their relative position, and the drawing order will be corrected.

The topic category, which must be defined when data is added to the system, provides the default name for the folder it is placed in when a layer is added to a map. Folder and Layer names can be changed – see below.

2.7 Layer Renaming, Category renaming
You can rename layers by right-clicking a layer, selecting “Layer Properties”, then “About”. You can rename a category by right-clicking it and selecting “Rename Category”.

2.8 Transparency Control
Right click on any layer (command-click on a Mac), then click the “Properties” tab, and adjust the transparency slider bar.

2.9 Bookmark and Embed Your Map in Another Web Page
In addition to being able to save changes to your map, it is also possible to save sub-views of your map using the “Link” button. These views can take the form of a bookmark URL or the form of an embeddable code snippet. The code snippet can be pasted into any web page to provide a live view of your map within a blog or any web page.
Create a view that you like and want to show to someone else. Then click the “Link” button at the upper left.

Now you have a bookmark URL for the view as well as an embed tag that you can paste into a blog or an HTML page.

Open a blog or page if you have one. If you don’t have one and would like to try this, go to http://blogspot.com and create a blog.

You can change the size of the embedded map by using the pulldown to change the height and width of the embedded map (measured in pixels), or by editing the height and width parameters in the code snippet manually.

2.10 Annotate a Map
WorldMap supports the creation of annotation in the form of point, line, or polygon for “marking up” a map with comments. Comments are public can be responded to by others. Note are turned off by default when a user opens a map by toggling “Show notes”.

2.11 Add External Data (Feed)
You can also load feeds from various systems. A feed is an XML web service which can take various forms. In the Add Layers, External Data tab, click “Add Feed”. (This functionality can also be accessed via the “More...” button in the upper right corner of the map.)

**Note on Flickr:** The Flickr layer will display results worldwide and won't refresh when panning/zooming, because of a bug in their API that doesn't accurately parse bounding boxes. Also for commercial feeds like Flickr, in general the API’s (methods for connecting to the commercial service) have been prone to break (as has occurred recently with Picasa and Youtube). For this reason we would not recommend relying on the photo display function for your work until we can come up with a more stable solution.

If you want to take these risks and have image or video content you want to have show up on WorldMap, you can load it to Flickr, provide locations using the Flickr location tools or, if you have it, key in an accurate lat/long. Then give your content one or more unique tags. Now when you user these keywords as your filter you will only bring in content you have uploaded.
You will see this interface:

Select Add Flickr Photos.
Type Feed title “Dance Photos”.
Type Keyword “dance”.
Select maximum results of 100.
Click “Add to Map”.

Zoom to the part of the world you are interested in.

A new Flickr photo feed layer is added to your list of map layers at the bottom.

To combine keywords with the OR operator, use "|", example: boston|maine (This will find all items which have tags for both boston and maine in them. This makes for broad searches.)

To combine keywords with the AND operator, use "+", example: boston+maine (This will find all items which contain tags for both boston and maine. This makes for focused searches.)

Save your map to keep this filtered Feeds layer handy and come back to it any time.

2.12 TweetMap: a Special Type of WorldMap Map
TweetMap \( http://worldmap.harvard.edu/tweetmap \) is an instance of a special kind of GIS platform specifically designed for handling extremely large datasets. The platform that runs TweetMap is called Map- D and was developed through a collaboration between Todd Mostak, (fellow at the Harvard Kennedy School and researcher at MIT), and the Harvard Center for Geographic Analysis (CGA).
The Tweets (point) layer is controlled by the Filter Term and Date/Time search parameters. The Tweet Heatmap layer is controlled by these as well as the display parameters. All of the search and display controls are described below:

**Filter Term:**
Use this to search for particular words or phrases. Spaces between words imply a logical “and”. If you use the term boston and harbor with a space between them, the system will find tweets with both the term boston and the term harbor in them, though the terms need not be in that order. If you use quotes, as in “boston harbor” the system will find only those tweets with that exact phrase in them.

**From:**
Set the start date and time for your time window. This is the time period that you want to query.

**End:**
Set the end date and time for your time window.

**Increment:**
Step forward or backward in time by day, hour, minute, or second. The place you start will be based on the time window you set above.

**Auto Max % (checkbox)**
This checkbox is on by default. This setting automatically chooses a reasonable value for Max % and changes that setting dynamically as you change your search parameters. Turn this off if you would like to override the automatic settings.

**Max %:** (Possible values: .01 to 20 (or 1 to 20%))
This setting defines the percentage of matching tweets within the aggregation unit which are assigned the highest color value of red. This setting is reflected in the legend created and the 5 classes below it are automatically defined based on it.

**Smoothing:** (Possible values: 1 to 40)
This setting defines the Gaussian smoothing parameter in pixels on the screen. This is currently based on pixels but eventually will be based on ground units.

**Min Tweets / 100 sq km:** (Possible values: 1 to 1000)
This setting defines the threshold for the total number of tweets within a square kilometer after the smoothing operation has been applied, below which tweets will not be displayed.

### 2.13 Map Click for Details
You can click on a map with multiple layers turned on and return attributes, by in effect “drilling” down at the point you clicked the map, through multiple layers and displaying the attributes on the right.

WorldMap will return attributes for as many (vector) layers as you have turned on. The layers will be listed at the upper right and the individual records will be listed in the panel below. You can select records grouped by layer in the upper panel and see the record highlighted on the map and attributes displayed in the panel below.
Each set of attributes will be presented with the layer it is from. Click the value for the layer and the feature will highlight on the map.

Sometimes when using the Identify command the feature for the wrong layer highlights when you click on it.

You need to have the layer that you want to highlight on top in the layer list on the left. You can change order by dragging layers up or down in the left panel. Layers which are on top on the left will display on top on the map. Put your points on top of your polygons if you want them to highlight. Then save your map. Then the points will highlight when using the Identify command. If polys are on top in the list on the left they will highlight. Attribute data will be returned for all turned-on layers and will be listed, but only the feature in the top layer will be highlighted. Remember any layer order change must be saved to take effect for the Identify command feature highlight to work.

For each attribute, the data value presented below the name of the layer it is in, is the value which is set as the first to display. The setting attribute display order is handled by the layer owner from the layer page under “update description of this data”. You can get to this location by right-clicking on the layer, then -> About tab -> Share Layer link -> “Update Description of this Layer” -> go to bottom of form. We hope to make this easier to set in the future.

2.14 Searching within a Layer
Any local vector layer can be search and matching features highlighted. To do this, use the search box at the bottom left, under the layer list. The search only works for text fields currently and wills search against all searchable text fields in the layer. If multiple layers are turned on, search will be done on the one that is displayed on top.

Defining which fields are searchable can be done by the layer owner by right clicking on the layer, then -> About tab -> Share Layer link -> “Update Description of this Layer” -> go to bottom of form. This are provides several ways to control how attributes are displayed and handled including whether attributes are searchable, field name aliasing (for Identify display), attribute display order, and whether attributes are displayed at all.

2.15 Street View
For many urban areas in the U.S. and increasingly around the world street level views are available from Google. For those areas along streets that Google has photography, street view allows the use to see what an actual ground level view looks like for a particular area in a map layer. This is information is particularly useful with data layers like the US Census data which covers large areas where street view photography is available and for which it can be useful to see what the landscape looks like at particular map feature locations.

Here are the parts of the world for which street view is currently available:
Select the “Street View” tool and then click on a street. If Street View is available for that location it will be displayed.

2.16 Google Earth View within Browser
Select the Google Earth tool and the 2D map will be replaced with the Google Earth globe with your layer draped on top of it. It may take a little while to load, especially the first time because you must load the Google Earth plugin. Each time you pan you must wait a couple seconds for your layers to redraw as this implementation does not use pre-cached tiles yet. Transparency is not supported yet, so it will often be best to view your layers one at a time. This is an abbreviated version of Google Earth without many of the features available in the full Google Earth application.

You can also view your layer using the full Google Earth application assuming you have Google Earth installed on your machine. This approach involves downloading the Google Earth version of your layer. To access downloads for a layer, right click on the layer name -> Layer Properties -> About -> Share Layer. In the upper right hand corner of the page you will see download options “KML” brings a KML Google Earth version of the file into your browser. “View in Google Earth” bring the layer in as a map service.

2.17 Legend, Scale Bar
WorldMap generates legends automatically based on the SLD (Styled Layer Descriptor) symbolization. Legends for any vector layers being displayed are in the Legend tab next to the Data tab at the upper left. The scale bar changes with zoom level and the exact scale ratio is displayed.
2.18 Downloads
Maps may be downloaded in a number of file formats including: ESRI Shapefile, Google Earth KML, Adobe PDF, Microsoft Excel, CSV (comma delimited text), GML (geographic markup language), PNG (image), JPEG (image).

To access downloads for a layer, right click on the layer name -> Layer Properties -> About -> Share Layer. In the upper right hand corner of the page you will see download options.

If you own or have edit access to a layer you can control whether downloads are enabled for a layer within the metadata edit form. To get to this form from the map, right click on the layer and select “Share Layer”, then on the lower right portion of the Layer page, under Manage Layer, click on “Update the description of this data”. Toward the bottom of the metadata edit form you will see a check box which determines whether people will be able to download the layer.

2.19 Printing
Click the “Print button. You will see this prompt:

If you want to print a simple map with the current map extent, click “OK”.
If you want to adjust the map extent, click “Cancel”, adjust map extent, and the print using your browser’s print button.

2.20 Downloading

Map layer data may be downloaded in a number of file formats including: Zipped ESRI Shapefile, Google Earth KML, Image service in Google Earth, Adobe PDF, Microsoft Excel, CSV (comma delimited text), GML (geographic markup language), PNG (image), JPEG (image).

To get to downloads, right click on layer and select “Share Layer”.

See download links at upper right corner of Layer page:
2.21 Revision History
At the upper right corner of the map is a “Revisions” link which brings up a list of snapshots of your map created every time you save. Use this tool if you want to go back to an earlier version of your map. This link will only show up if you have Manager level permissions to the Map you are viewing.

3.0 Create Your Own Map
3.1 Registering
To register click “Sign In” on the front page, then click “Register”. Fill out your username, email address, password, and if you are Harvard check that. If so you will be sent to a page to verify your Harvard ID. (There is no difference in functionality between Harvard and non-Harvard. We are starting to allow access control by group and Harvard is the first group we have enabled.) You will then receive an email with a validation link that you must click to be registered. Now you have an account and a profile and you can log in on the front page.

NOTE: Unregistered users can view all public content on the system and can make temporary changes to Maps created by others. Registered users can create their own Maps, upload materials, change symbolization, and save changes. In addition registered users can control access to layers they own and can access any private content that has been made accessible to them by others.

3.2 Filling in Your Profile
Profiles allow people to find out about other users of the system. A user’s profile name is associated with any layer or map they create. Once you are logged in you can go into your profile and add information about yourself. As you add materials to WorldMap, those materials will be listed here.

NOTE: The user profile contains at a minimum the user’s name and email address. Other optional items include organization, position, phone, fax, address, city, state, zip, country.

3.3 Certifying a Map
A certification tool makes it possible. To certify a layer

3.4 Rank and Comment on a Map
3.5 **Create a Map**
Click “Creating a Map” link at the top of the page. A blank map template displaying the Google Terrain base map appears. Zoom to some part of the world and start to build your map. Try Zooming using the shift-drag approach.

3.6 **Change Base Map**
Select from the list of available basemaps in the layer list on the left.

3.7 **Saving your Map**
Save the map. Click “Save” and here we have several items we can define as we save the map.
- **Name** - This is the name as it will show up in the map search tool. The name is also displayed on the header at the top of the page.
- **URL** – You decide what is displayed at the end of the URL. Example: http://worldmap.harvard.edu/alpha/maps/mytest
- **Abstract** – A short description of the Map. This and the title are used by map search.
- **Keywords** – Words that are used to filter feeds Picasa and HGL. Separate keywords with a space. A space acts as an “or” operator to make your filter more general.
- **Description (About page)** – Formatted text which appears in an introduction box when the site is first opened by a user. This content also appears when you click on the “About” link at the upper left. Within the text editing area it is possible to insert photos of videos by clicking the “Upload Images” button. By clicking within the text editing box and then clicking on the HTML button, it is possible to insert HTML such as embed snippets to videos here.
- **Banner** – Currently it is not possible to add a banner to your Map yourself but you can send us one and if time allows we will add it. Banners should be 50 pixels high and if the width is less than ~2000 pixels then it should have a solid background color or fade to a solid background color on the right side, so it can be blended in with the page header area if/when the browser window is wider than the banner.

3.8 **Permissions, Map Name, Profile**
Once you have created and saved a map, you can control who else in the world can see it. Click on “Share Map” link at the upper right and you can make your map private or share with just a couple people or open it to the world. If you want, you can choose to only allow certain people to make changes to your map.

<table>
<thead>
<tr>
<th>Permission Level</th>
<th>Can View a Map</th>
<th>Can Download a Layer</th>
<th>Can Edit a Style</th>
<th>Can Add/Remove a Layer</th>
<th>Can Change Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>View</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Edit</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Manage</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

*Overview of Map level permissions*
NOTE: You can also control permissions on layers in your Map. If you want, you can create a map which is public and includes some public and some private layers.

Once you have created a Map or loaded new data to WorldMap, a link to that material shows up in your profile where others can see what you have created. If a map or layer is not public for viewing, the name of it will still show up here.

4.0 Adding Layers to your Map

There a number of ways to add layers to your map. Once you have created a map (or while you are within someone else’s map - though you won’t be able to save your changes) click on “Add Layers“ link at the upper left. You will see 5 tabs:

1. **WorldMap Data** – this lets you search for data which others have uploaded to the system and shared.
2. **External Data** – this lets you point to external servers using URLs which point to web services on those servers. These web services can be either in the form of OGC (Open Geospatial Consortium) Web Mapping Services or ESRI REST services.
3. **Upload Layer** – this lets you upload your own Shape or GeoTIFF file from your own hard drive.
4. **Create Layer** – this lets you define a point, line, or polygon layer and start creating it and editing it directly in the browser.
5. **Rectify Layer** – this points you to a sister WorldMap system called WorldMap WARP (which is based on the NYPL Map Warper developed by Entropy Free) where you can upload scanned maps and georeference them directly online, then bring them into WorldMap.

**More... Tool** - Another way to add layers includes using the “More..” tool at the upper right. This tool uses GeoRSS to bring in media layers from YouTube, Picasa, and Harvard Geospatial Library(HGL). The filter used by this tool is defined in the “Save” form. This will be moved to a more logical place sometime soon. Layers loaded from the More tool cannot currently be saved in the Map.

Data found this way from HGL part can be loaded to the map directly as remote web services and saved. This is the beginning of a possible simple federation approach that could be used to share geospatial materials between libraries even when the GetCapabilities approach become cumbersome because of too many layers. Of course OpenGeoPortal [http://code.google.com/p/opengeoportal/](http://code.google.com/p/opengeoportal/) provides another nice approach to layer federation.

4.1 **WorldMap Data**

Click on the “Add Layers” link and then the “WorldMap Data” tab. You can filter your search for layers using text combined with the map extent. Make sure the “Refine Search” by area toggle is on if you want to filter by geography as well as text or instead of text.
Highlight the layer you want to add, then click “Add Selected Layers” at the bottom.

Close the form and you will see the layers you added. Layers will be added to folders based on their category designations.

4.2 Adding External Map Services

WorldMap supports the addition of service enabled layers to a map via a “web map service”, also known as a WMS. WorldMap also supports the adding of ESRI REST service layers to maps.

Given a WMS URL to a remote server, WorldMap will request a list of all the Layers on that remote server, and displays the list in WorldMap for the user to select from.

For a remote WMS or ArcGIS REST services to work, the services need to support one of the following projections: EPSG:900913 or EPSG 3857.

To see whether a WMS or REST service supports one of these projections, load the URL to a web browser and view the resulting XML document. In the XML document under the <SRS> tag, look for EPSG:900913 or EPSG 3857. If you don’t see those projections listed then the layer will not display in WorldMap.

WorldMap currently supports use of the Identify command to return attributes from a WMS service layer based on a map click. WorldMap also supports WMS legends. For either Identify or Legends to work, the remote WMS server naturally has to support those WMS features.

Example 1: Steps for loading Esri REST layers from the Coalbed Methane WMS server to WorldMap

1. Login to WorldMap and go to the map that you would like to add Coalbed Methane layers to.
2. Click “Add Layers”.
3. Choose the “External Data” tab from the “Add Layers” dialog box.

4. Click the “Add another server” button.
5. Now you need to get the WMS URL to paste into the “Add another server” form. Here is the Coalbed server URL: http://maps1.arcgisonline.com/ArcGIS/rest/services/EIA_Coalbed_Methane_Field_Boundaries_2007/MapServer/.

6. Paste URL into URL form.
7. Toggle ArcGIS REST, click “Add Server.”
8. You will then see:
9. Select the layers you want to add and click “Add Layers”.

10. The layers you select will show up in the Layer list to the left of your Map.

11. Save your Map so you can easily come back to the Layer.
4.3 Upload Layer

To upload a shapefile to WorldMap, click “Add Layer” and select “Upload Layer”.

**WARNING:** Currently any uploaded layer which can be viewed by the public is also technically downloadable even though it may appear not to be. There do exist custom layers in WorldMap which reside on a separate server and can be viewed but not downloaded, but the ability to make layers viewable but truly not downloadable is not yet enabled in the WorldMap interface.

Now choose the required parts of the shapefile starting with the “.shp” part and continuing with .dbf, .shx, and .prj parts. You can optionally include an SLD for styling. You can also optionally define the text encoding if you know what it is, though for this layer the default is appropriate, Latin 1. For example, if you knew you had Japanese or Arabic characters in your file, you might choose UTF8 instead of Latin 1, or for Chinese you might choose GBK. UTF8 is a sunset of the Unicode standard compatible with ASCII and can handle almost all symbols in all languages.

Items with an asterix (*) are required.

*Title: Give your layer a title.

*Data: Choose a Shapefile (.shp part) or zip compressed shapefile or GeoTIFF as your data to load. If you use a zip compressed shapefile, be sure the zip file contains the .shp, dbf, shx, and prj parts of the shapefile.

HINT: You will increase your chances of a successful upload by having your shapefile or GeoTIFF file be in the “plain vanilla” projection space, Geographic WGS 84, also known as EPSG:4326. To know whether your shapefile is in this space, the contents of your .prj file will look like this in a text editor:

```
GEOGCS["GCS_WGS_1984",DATUM["D_WGS_1984",SPHEROID["WGS_1984",6378137.0,298.257223563]],PRIMEM["Greenwich",0.0],UNIT["Degree",0.0174532925199433]]
```

You may not have a .prj file for your GeoTIFF as it is not needed since the projection information for a GeoTIFF is stored in the header of the GeoTIFF.

If your .prj file does not look like this, the upload may still work fine. If it doesn’t, the most likely culprit is the projection space. The best way to fix that is to use an application like ArcGIS or QGIS and reproject your file to Geographic WGS 84. This can be done for shapefiles or GeoTIFF files. Check with us on how to do a reprojection if you need help.

SLD: Optionally provide an SLD. This is an XML document that you would have created using the ArcMap2SLD or QGIS tools (see Section 5 below).

*Abstract: Provide a description of your data. More information is better. At the very least when you add real data, please include a brief description of the data, who created it, for what purpose, and when. Please
also include source materials used to create the data layer. This information is important both for you to remember what the data is about, and to allow someone else a chance to benefit from your work (assuming you want to make the data available for others to use at some point).

**Permissions:** Default permissions are set such that the world can view it but only you can change it. Add individual users to define who can edit (modify the style), or manage (delete layer, change permission settings).

<table>
<thead>
<tr>
<th>Permission Level</th>
<th>Can View a Layer</th>
<th>Can Download a Layer</th>
<th>Can Edit a Style</th>
<th>Can Add/Remove a Layer</th>
<th>Can Change Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>View</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Edit</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Manage</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

*Overview of Layer permission settings*

If you select a GeoTIFF file for the *Data* item above, the view will remain the same. If you choose a shapefile, (the part of the shapefile with the “.shp” ending), the view will change to handle the additional parts of the shapefile as shown below as well as an optional encoding selection:

*Data:* Choose the .shp portion of the shapefile

*DBF:* Choose the .dbf portion of the shapefile

*SHX:* Choose the .shx portion of the shapefile

*PRJ:* Choose the .prj portion of the shapefile

**Encoding:** Choose an optional encoding. The default is Latin1.

NOTE: A number of character encodings are supported including UTF8/Unicode, GBK, and Latin1/ISO-8859-1 to Latin15/ISO-8859-15, and in addition various Windows encodings. Specific encodings can be set when a layer is being uploaded. The default encoding is Latin1.

You must read and agree to the Terms and Conditions.

Click “Upload” and once uploaded you will be presented with a metadata form (see below).

**4.3.1.1 Metadata**

NOTE: Users uploading new layers are prompted to fill in both optional and required descriptive information about the layer. Required items include: Title, Abstract, Keyword, thematic category (ISO 19115 format). Eventually Author, Source, and Date will be included as options in the metadata editor.
Once the file has been uploaded, the only additional required items are Keyword and Category, though there are useful metadata fields here which we strongly encourage you to make use of. Items with an asterix are required.

*Title  Provide a title for your dataset. We recommend using the following naming convention:

<geography - continent, country, state, or city>_ <what it is>_<date data represents>_<optional version>_<optional tmp if it is for testing purposes and can be removed after a week>

Example:
africa_ethnographic_1959_2_tmp

Date  This date is filled in automatically with the date of upload, but can be changed.

Date Type (creation/publication/revision) Choose type of date you want to describe. The default type is “creation”.

Edition  Use this field to describe the edition.

Abstract  Give an overview of the dataset. What does the data represent? Who created it and when? What sources were used?

Purpose  Describe briefly how the data can be used.

Maintenance Frequency  How often is the data updated?

*Keywords  Add keywords that will be useful handles others can use to find the dataset. Separate keywords with a space.

Keywords Region (under construction) Select a major region of the world. Other regions in addition to countries will be added.

Constraints Use
How do you want to define the rules governing the use of this data? We encourage users to adopt an appropriate Creative Commons (http://creativecommons.org/) license to define the type of attribution the data requires. The license should specify whether the data can be used commercially and under what conditions modified versions can be redistributed.

For example if you would like to restrict use of your data to non-commercial uses and don’t mind others using as long as they provide proper attribution and don’t mind others modifying your work and redistributing modifications as long as this license is attached, we would suggest a non-commercial share alike license such as this one: http://creativecommons.org/licenses/by-nc-sa/3.0/. Or feel free to create your own license. If you do, include the URL to the license here in the Constraints Use section.

<table>
<thead>
<tr>
<th>License Scheme</th>
<th>Can someone use it commercially?</th>
<th>Can someone create new versions of it?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attribution</td>
<td>![F]</td>
<td>![T]</td>
</tr>
<tr>
<td>Share Alike</td>
<td>![T]</td>
<td>![F]</td>
</tr>
<tr>
<td>No Derivatives</td>
<td>![T]</td>
<td>![F]</td>
</tr>
<tr>
<td>Non-Commercial</td>
<td>![F]</td>
<td>![F]</td>
</tr>
<tr>
<td>Non-Commercial Share Alike</td>
<td>![F]</td>
<td>![F]</td>
</tr>
<tr>
<td>Non-Commercial No Derivatives</td>
<td>![F]</td>
<td>![F]</td>
</tr>
</tbody>
</table>

List of common Creative Commons License schemes

Below are links to further information for each type of constraint listed:

- Public Domain Dedication and License
  http://opendatacommons.org/licenses/pddl/
- Attribution License (ODC-By)
  http://opendatacommons.org/licenses/by/
- Open Database License (ODC-ODbL)
  http://opendatacommons.org/licenses/odbl/
• CC-BY-SA
  http://creativecommons.org/licenses/by-sa/2.0/
• Copyright
  http://en.wikipedia.org/wiki/Copyright
• IntellectualPropertyRights
• License
  http://en.wikipedia.org/wiki/License
• patent
  http://en.wikipedia.org/wiki/Patent
• patentPending
• trademark
  https://en.wikipedia.org/wiki/Trademark

Constraints Other Include any additional constraints.

Spatial Representation Type
• grid – raster dataset such as georeferenced satellite image or scanned georeferenced map in GeoTIFF format.
• stereoModel – currently not supported unless stored in a GeoTIFF or Shapefile format
• textTable - currently not supported unless stored in a GeoTIFF or Shapefile format
• tin - currently not supported unless stored in a GeoTIFF or Shapefile format
• vector – point, line, or polygon dataset in ESRI Shapefile format.

Language Please choose the language closest to the language used in the attribute table if the dataset is a Shapefile and for the language used on the map if the dataset is a GeoTIFF.

Temporal Extent Start Date (Under construction) Use only a start date if a date range does not make sense for your data. This date should describe the “temporal footprint” of the data. What time period does it describe? This is generally not the date the data was published.

Temporal Extent End (Under construction) Use an end date if the data in your layer is best presented by a date range.

Geographic Bounding Box This describes the theoretical box necessary to enclose the data geographically and is automatically calculated by the system. It can also be modified here. The projection system used to define the bounding box is also defined here.

Supplemental Information Additional information about your data.
**Distribution URL**  This URL is calculated by the system. This URL displays this data layer along with information about it and is a possible form of citation.

**Distribution Description**  (Under construction)

**Data Quality Statement**  Add any information you have describing data quality.

**Point of Contact**  Person who should be contacted with questions about the data.

**Metadata Author**  Name of the person who created the metadata.

**Category**  These are ISO 19115 categories and help make it possible for queries from other system to return meaningful results.

**Attributes**  For Shapefile datasets an attribute control table is automatically generated with the following columns. These controls let the user control how attributes are displayed when using the Identify tool and clicking on a feature to return attributes in the right-hand panel:

- **Attribute**  Lists the fields in the database.
- **Display Title**  Is used to control how the fields are displayed when a user clicks on the layer on the map and returns attribute information in the panel to the right.
- **Display Order**  This is the order in which the attribute information is listed when returned in the panel to the right after a click on a map.  **NOTE:**  The field which is displayed first is used in the summary table in the upper part of the panel to the right.  It is best to designate a field to be first which provides meaningful information at the record level.
- **Visible?**  This toggle determines whether a given field is displayed at all when one clicks on the map using the Identify tool.
- **Searchable?**  This toggle determines whether the field will be searchable from the text search box to the lower left of the map.

### 4.3.1.2 Troubleshooting Shapefile Uploading

If the layer does not upload there are several possible reasons why:

1)  The projection is not being read properly. If the layer is not already in Geographic WGS 84 space, also known as EPSG 4326, project the shapefile to that space and try again.

2)  The SLD file is not correct. Check and make sure that you have made the required changes to the file as defined above.

3)  Check to see that the XML is valid:  [http://validator.w3.org/#validate_by_input](http://validator.w3.org/#validate_by_input)

4)  Check to see that the SLD file was created for this shapefile and not another shapefile. The fields described in the SLD should match the fields in the shapefile.

If all else fails, project your file to Geographic WGS 84 (we can help) and don’t include any SLD.
4.3.2 Upload GeoTIFF

Raster files are images and can be satellite imagery or scanned maps which have been georeferenced. GeoTIFF files are rasters and have all the necessary information for display and georeferencing in one file.

Click “Add Layers” and “Upload Data”. Now give it a title. Choose the elevation.tif file to upload. Provide abstract information and click “Upload”. Fill in a keyword and category. Notice that there are no fields for raster layers. This means there will not be information returned when the layer is clicked on, unlike shapefiles which contain attributes.

Raster (GeoTIFF) images do not have the same type of styling options as vector (shapefile) layers do.

4.3.3 Uploading a TIFF Created with ArcGIS

ArcGIS allows one to save out a TIFF file version of a raster dataset generated. Though this is not a GeoTIFF and cannot be directly loaded to WorldMap, it can be easily converted using the Global Mapper software package. These instructions will also allow you to define a transparent background for the image you want to bring into WorldMap:

1. Export the raster image from ArcMap in TIFF format.
2. Open the TIFF format raster image in Global Mapper.
3. Go to Tools -> Control Center -> Options. In the Display tab, “set transparent color” to be the same color as your raster image background in the image you brought into Global Mapper.
4. Go to File -> Export Raster and Elevation Data -> Export GeoTIFF.
5. In the GeoTIFF Export Options, choose File Type to be “24-bit RGB”, check “Make Background(Void)Pixels Transparent”. Click OK.
6. The output file should load properly to WorldMap

4.3.4 Permissions

Users can control whether others can see and/or modify the layers they load to their Map. Layer permissions are added using email addresses, as with a Google Doc. Layer permissions can be set at the time of upload and can be modified as needed later. Currently the only group authentication control is for Harvard and uses Pin authentication via an Isites page.

**WARNING:** Currently any uploaded layer which can be viewed by the public is also technically downloadable even though it may appear not to be. There do exist custom layers in WorldMap which reside on a separate server and can be viewed but not downloaded, but the ability to make layers viewable but truly not downloadable is not yet enabled in the WorldMap interface.

4.4 Edit Existing Layers

Users can edit any vector features that are within layers they have edit rights for. To edit a given feature:

1) Highlight the layer it is in by clicking on the layer name in the list to the left of the map.
2) Select the “Edit Feature” button from above the map.
3) Click on the feature on the map you wish to edit.
4) A small pop-up displaying the attributes of the feature will appear. Click “Edit” on the pop-up and you will be able to edit attributes or the actual map geometry of the feature.
5) Click save when you are finished.

Editing a layer can cause the layer’s map extent to change. It can take up to 10 minutes for a recently edited layer’s map extent to be updated.

4.5 Creating a layer using desktop software
You can use QGIS or ArcGIS as well as many other desktop packages to create shape files. Here is a tutorial by Lex Berman which uses the open source QGIS platform.

http://maps.cga.harvard.edu/qgis/

This tutorial covers creating and editing shape files. For uploading to WorldMap it is best to use the Geographic WGS84 projection space. Also, if you use special character encodings to handle particular languages in your attribute table, be sure to define the encoding you use when you upload to WorldMap.

4.6 Create Layer
Go to “Create Layer” tab in Add Layers form.

1. Define layer by giving a Name, Title, **choose Data Type (point, line, or polygon)**, leave Projection alone, Add short Abstract, add Keyword, agree to Terms and Conditions. Then click “Create”.
2. The only additional metadata you must add is the Category designation at the bottom. AT A MINIMUM, PLEASE PROVIDE BASIC INFORMATION ABOUT YOUR DATA: DESCRIBE WHAT THE DATA IS AND WHAT SOURCES IT IS BASED ON. DESCRIBE THE PURPOSE FOR THE DATA.
3. Click Submit.
4. Your empty layer will be loaded to your map ready to digitize into.

4.7 Create Features and Embed Media in Them

After completing the Section above and creating a new layer, you are ready to start adding content to your Layer.

1. With your new layer highlighted, click the “Create Feature” link above the Map.
2. Now zoom to the area of the Map where you want to create your new feature.
3. As you click on the map you will be starting to draw your feature. If you are creating a point layer, a single click will generate a new feature and an attribute form will come up to allow you to add in attributes. If you are creating a line, two points will suffice. For an area or polygon, you can keep clicking points as long as you want. Double click to close the polygon.
4. After you create a feature a form will come up to allow you to add attribute information for the feature. You can add values for Name, Description, Start date, End Date, String Value 1, String Value 2, Number Value 1, Number Value 2.

NOTE: Description is a special field which supports HTML. This means one can include media such as video, photos, sound, etc. which will display when users use the “Identify” tool with these features.

There are two ways to embed media within the Description field. One can click on the “Upload Images” button and insert media directly in line with the text, or one can use the HTML button to add HTML embed code to the Description field.

5. To add HTML to the Description field:
   a. Click on the empty Description box to add content. A rich text editor will appear.
   b. Type any text you want to display and format it with the tools provided.
   c. If you want to include video or any other media via an “embed snippet of HTML”, first click in the description box then click on the blue HTML box (the last icon on the right).
   d. A new “Edit HTML” view will open. Paste your embed snippet in the line below the HTML “<br>” text displayed.
   e. Here is an example of an HTML snippet for an image to add:

   ```html
   <img src="http://thoreau.eserver.org/lAphoto.jpg" width="580" height="235">
   
   This snippet was created for an image by gathering the URL and image size for that image by (in a Firefox browser - other browsers will be slightly different) right clicking on the image in question and then clicking “view image info”, then inserting those pieces of information into the format shown above to create the HTML snippet. Below is the “view image info” display that you get your URL and size information from.
This is how it works in Firefox, other browsers will be slightly different.

In Chrome, right click and click “Copy image URL” to get URL. Then right click again and click “Inspect Element” to get size.

In Internet Explorer, right click in image and click “Properties”.
f. Now that you have created your snippet if you haven’t already done so, click in the description box for the feature you want to add the image to, then click on the blue HTML box (the last icon on the right).
A new “Edit HTML” view will open. Paste your embed snippet in the line below the HTML “<br>” text displayed.

Save your feature edit form. Now select the Identify tool above the map and click on your feature. Your image should appear along with other information you added about your feature.
You can resize the way you image appears by changing the size values but to avoid distorting you image you must keep the ration between the width and height values the same.

6. Uploading a file which has an HTML field

One can upload a shapefile to WorldMap which has an HTML field. Here is how to do it:

h. Click “Submit Query”.
i. You should now see the Video loaded to your Description section. Click “Save”.
j. Now you will see the attribute form. Click “Save” on the bottom of the form.
k. To see how others will see the attributes you have added for this feature, click “Identify” tool above the Map, then click on the feature you have just edited. Your video should appear, ready to be played along with anything else you added.
a. The field which contains the HTML must be called “description” (no final ‘n’) or “Description” (caps sensitive).
b. There can be no more than 255 characters in the field or it will fail to save. This is only a limitation when uploading a shapefile, not when creating the HTML content online using the “Edit Feature” tool.

7. To edit the geometry or attributes of any vector layer you have edit permissions for:
   a. Highlight the layer you wish to edit.
   b. Click the “Edit Feature” link above the Map.
   c. Click on the feature you wish to edit to select it.
   d. Click “Edit” at the bottom of the attribute form. Now you can edit the geometry of the feature or the attributes of the feature. To edit the geometry, click on a vertex (white box) on the feature and drag it. To add a new vertex, click on the faded vertex between two existing vertices and drag. To edit attributes, click in the attribute form for the attribute you want to edit and make any changes.
   e. When you are finished editing geometry and attributes, click “Save” at the bottom of the attribute form. Then close the form by clicking on the ‘X’ in the upper right corner of the attribute form.

4.8  Rectify Layer
To georeferenced your scanned maps online, go to Add Layers, click on the “Rectify Layer” tab, the click on “WorldMap WARP” or go to http://warp.worldmap.harvard.edu.

A video demonstrating how to use WorldMap WARP is here.

Create an account in WorldMap WARP. Eventually you will not need two accounts, but now you do. Upload any scanned map you would like to georeference: click “Upload Map” tab, then fill in metadata, then browse to the image file you want to upload, choose whether you want the map to be public or not, and click “Create”.

The map should now be displayed un georeferenced. Click on “Rectify” to define corresponding points between your scanned map and the Open Street Maps global base map. The link just below the map, called “Advanced Options” allows the user to choose the rectification method and the sampling method, should they choose to override the automatic settings.

4.8.1 Adding georeferenced maps to WorldMap
Once the scanned map is georeferenced it can be exported in several ways including as a GeoTIFF that can be used in other system and also a way that can be easily brought into WorldMap.

To do this, click on the “Export” tab. Right-click on “Tiles base URL” link and choose “Copy Link Location”. Now go to your WorldMap map and go to “Add Layers”. Then go to “External Data” tab. Click “Add another server” then paste the URL you just copied from the Georeferencer. Be sure it is set to “WMS”. Click “Add Server”.

WorldMap Help
You will now see a list which gives the name of your layer and the name of the server. Click on the name of your layer and then click “Add Layers” at the bottom. Now close the “Add Layers” window.

At the bottom of your list of layers on the left in WorldMap you should see the layer you just georeferenced show up. If your new layer is not visible, right click on the layer name of the new layer and select “Zoom to Layer Extent” to see your map.

Save your map so that when you come back to your map your new layer will remain visible in your map.

4.8.2 Masking your map

Note: The masking function is buggy. We hope to get this fixed but there is currently no funding for this.

You can mask your map by drawing a line around only the area you want to display. One you have uploaded and georeferenced (rectified) your map, go to the Crop tab.

1. Click the “Draw Polygon” tool to the right of the hand “Move Around Map” tool.
2. Click on the map to draw a polygon around the area you wish to keep.
3. Double click to close the polygon.
4. Click “Mask Map!” at the bottom of the page to apply your mask.
5. You can select your polygon and delete it using the “Delete Polygon” tool.
6. You can delete you mask by clicking the Delete Mask link at the bottom of the page.

5.0 Changing Map Cartography

In addition to controlled data sharing, one of the key benefits of WorldMap is cartographic expressiveness. The Style tool allows you to create SLDs or Styled Layer Descriptors which are XML documents that define the way a layer looks.

To define the cartographic appearance of a Layer, the user can create Styles for that layer. Styles can be created for both raster (image) and vector (point/line polygon) data types, but the options are richer for vectors. There are online tools for styling vector layer, but one can also create styles using desktop tools like ArcGIS and QGIS, then upload them together with the layer to be symbolized.

To create a Style for a layer in WorldMap, (whether using online or desktop tools) one is creating a Styled Layer Descriptor(SLD) XML document which is stored in WorldMap. The SLD is used to control how the layer is displayed. It is possible to define more than one style for a given dataset. One can then choose which style to use after the layer has been loaded to the map. The layer will at first appear using the default style, but other styles are available to be chosen instead.
5.1 **Online Styles Creator**

**NOTE:** Users can modify the way a vector (point, line, or area) map is displayed, and control the color of lines or area fills as well as labels. Users can also use rules to support complex symbolization schemes based on database and scale conditions. WorldMap uses an open format for symbolization called SLD (Styled Layer Descriptor). SLDs created can be uploaded to WorldMap and used to symbolize a given layer.

It is possible to edit map styles and create new styles in WorldMap. Styles are created using one or more rules. Each rule can have several parts, including a label, coloring, scale dependency, and one or more database conditions.

At the top of the tool you can choose between existing styles for a given layer, copy an existing style, or edit an existing style, or create a new style from scratch.

Let’s start by editing a rule from the currently chosen style. Select the rule and click Edit. There are three tabs containing options for defining the rule you are editing. Aspects of a rule that you set in the various tabs are cumulative for a rule so for example you create a rule by setting the color in the Basic tab and then a database condition to control when that color is displayed in the Advanced tab.

In the Basic tab it is possible to:
- change the name of the style
- change its fill and outline color (if it is a polygon)
- control opacity of line or fill
- control line width and line style

In the Labels tab it is possible to:
- Select a field to use as content for your labels
- Choose a font type and size and style for the Label
- Choose the color for the Label as well as the opacity
- Choose a halo (background color) for the Label, including its color, size, and opacity

In the Advanced tab it is possible to:
- Limit the display of whatever you have defined in Basic and Label tabs in terms of maximum display scale and minimum display scale.
- Limit the display of whatever you have defined in Basic and Label in terms of one or more database conditions. It is also possible to set multiple groups of conditions.

Explore how:
- Polygon styles can be changed.
- To modify simple style in terms of fill, outline, opacity.
- To set label and scale dependency (LandType)
- To set a database condition for a rule and combine it with another database rule. (Suitability > 50).
• Show how to create a new style from scratch or duplicate one.

5.2 Using Multiple Styles

WorldMap supports the association of multiple styles with a single data layer. The user can choose the default style within the “Share Layer” page. After a layer is added to a map, the style can be changed from the default style to another one. It is possible to load the same layer to a map several times and have it displayed each time with a different style.

Currently users can upload one style at a time along with a layer. There is no way yet for users to associate more than one style with a layer, however a WorldMap administrator can do that – contact us at worldmap@harvard.edu.

5.3 Classify Tool - Creating Complex Styles Automatically

The Classify tool allows one to choose a variable (column in the database behind your point/line/polygon layer) and use that to define the symbology for your map. (Styling can only be performed on layers you have edit access to.)

In this example we have a census tract layer for Boston.

Each polygon in this layer is linked to the following fields of information about it.
Right click on the layer listed to the left and choose “Edit Styles”:

Create a new style:

Name your new style in a way that describes what it depicts:
Click the “Classify” button:

Choose the attribute (variable or column for your data layer) that you want to use to drive the symbology, then select the number of categories you want to create (in this case 6), then choose the way in which you want to divide your polygons into categories (in this case Equal Interval), then choose the color ramp you want to use (in this custom from light red to dark red).
Click “Apply” and “Save” if you want to keep it the new style.

### 5.4 Desktop Styles Creation

We are hoping the tools below will become less necessary given the existence of the Classify tool implemented within WorldMap. For this reason we do not plan on updating these tools. The last version of ArcMap2SLD will be 10.1

#### 5.4.1 Using ArcMap2SLD in ArcGIS 10.1

This approach allows you to take advantage of some of the symbolization power of ArcGIS and apply it to your WorldMap layer.
The latest version, ArcMap2SLD 1.3, which runs in ArcGIS 10.1 on the 64 bit version of Windows 7, is here: http://worldmap.harvard.edu/media/ArcMap2SLD.zip.

The earlier ArcGIS 10 version for Windows XP is here: http://wald.intevation.org/projects/arcmap2sld.

The ArcGIS 9.3 version is here: http://wald.intevation.org/frs/?group_id=32

To get started with the latest version open ArcGIS 10.1 and load the layers you want to symbolize and add to WorldMap to your MXD. Once you have symbolized your layers, start ArcGIS2SLD. (Currently this tool works best with capturing the colors of point, line, and polygons layers.)

Define a path and name for the SLD file you want to create.

**IMPORTANT:** Uncheck “Include Layer Names” under Extras.
If you would like to include only selected layers (this is not the same as turned-on layers) to be exported from your ArcGIS map to SLD, check “Selected Layers”. If you have multiple layers in the map you are exporting, you will need to also check “In Separate Files”. The tool will then create separate SLD files, one for each layer in your ArcGIS map. To load these to WorldMap you will need one SLD for each corresponding shapefile you wish to symbolize. Click the blue SLD button at the bottom left to create your SLD files.

Note on Multiple SLDs for a Single Shape File
If you want to create multiple SLDs for a single shapefile layer, create the SLDs then contact us at worldmap@harvard.edu. If you email us the SLDs and tell us which layer you would like them associated with we can make the association for you. There is currently no way for end-users to upload multiple SLDs for a given shape file layer.

Pros & Cons for Using ArcMap2SLD in ArcGIS 10 method
Pros:
- ArcGIS 10.x is the most commonly used commercial software package and many people are familiar with it.
- One can create multiple SLDs at one time, great for large number of layers or for a single layer for which you want to style in multiple ways.
- There are no additional changes in the SLD document required, just make sure to uncheck “Include Layer Names” option.

Cons:
- Does not recognize <all other values> category/class in the layer properties -> symbology tab if you want to classify by “unique values” in ArcMap 10.1. Simple fix: add all unique categories, and then group the selected ones as “all other values”. For example, imagine you have 2 categories: “missing values” & “blank” that you want to assign one color as “missing data”. Grouping those 2 categories into one makes it work for SLDs.
- Does not work with Layer Properties -> Definition Query in ArcMap 10.1. For example, if you want to display only selected records from the data, you should use the symbology tab instead, or alternatively create a new shapefile with the selected records only.
- Does not work for layers grouped together. Simple fix: ungroup the layers when creating multiple SLDs.
- Does not recognize Display -> Transparency in ArcMap 10.1. For example, if you set the transparency layer to 50%, the SLD will take it as 100% color. In other words, when you upload the layer to WorldMap you will not see it transparent, instead you will see it as a lighter shade of the solid color you chose. This can be remedied in WorldMap by changing transparency at the Layer or Style Rule level.
- Does not work with charts, such as pie chart or bar chart symbology.

5.4.2 Using “Save as SLD” plugin in QGIS 1.7

QGIS is an open source desktop GIS software application, available for free download at http://www.qgis.org. Use QGIS 1.7 desktop application to create your maps and symbolize your layers, and “Save as SLD” plugin to export them to SLD styles.

To install “Save as SLD” plugin in QGIS, go to Plugins -> Fetch Python Plugins -> Repositories tab.

IMPORTANT: Click on “Add 3rd party repositories” and click OK to the message prompt.

Then click on “Plugins” tab and filter for "SLD", select “Save as SLD” and install plugin.
“Save as SLD” should then appear under the Plugin dropdown menu.

After styling your layer, simply click on Save Style as SLD and specify the path for the layer style.

**Pros & Cons for Using “Save as SLD” plugin in QGIS 1.7 method**

- **Pros:**
  - QGIS is an open source desktop GIS application, available for free download.
  - QGIS is easy to use and learn.
  - Runs on various OS, including Windows 7 64 bit OS as well as Macs.
  - SLD plugin is easy to install.
  - No additional changes in the SLD style code are required.

- **Cons:**
- No option to export multiple SLDs, export one layer at a time; hence, not good if you have large number of layers.
- No option for styling with proportional symbols by size. For example, styling layers with point feature data to represent various sizes in points based on the quantity they represent is not an option in QGIS styles.
- Does not work with charts, such as pie charts or bar charts.

5.5 Creating Raster Styles with Desktop Software (Advanced)

Raster (GeoTIFF) images do not have the same styling options as vector (shapefile) layers do. However, you may still need to define transparency levels to selected areas in your image. For example, if you have an older scanned map that has been georeferenced (assume that the map has a white background), and you need to make the white areas transparent. In such case, you may find the next section helpful as it walks you through the steps for defining transparency to selected areas in your GeoTIFF. **Note:** in order to follow the instructions below and upload your raster image to the WorldMap, you need to make sure that it is a GeoTIFF image.

**Steps for adding transparency to selected areas in GeoTIFF (advanced level):**

1. Find out where your GDAL utilities are located. If you have QGIS installed on your computer it is likely to be here: `C:\Program Files (x86)\Quantum GIS Wroclaw\bin`
   **Note:** GDAL is a powerful tool for working with raster images such as GeoTIFF. Hence, if you don’t have GDAL utilities installed, you can download it from [http://www.gdal.org/](http://www.gdal.org/).
2. Use `gdalinfo` utility to find out all the information about your raster data. First, in the Windows command line (cmd), change directory to your GDAL utility files directory by typing:
   ```
   cd C:\path to your GDAL utility files
   ```
   For example, in my case the path is the following:
   ```
   cd C:\Program Files (x86)\Quantum GIS Wroclaw\bin
   ```
   Then use gdalinfo to find out info about your raster data:
   ```
   gdalinfo C:\path_to_your_raster\your_raster.tif
   ```
3. Look into the results and find out what kind of raster data you have.
   a. If you have a 3 band raster file with 8 bit pixels, and you want to make all white pixels in the image transparent, you would create an alpha channel using `gdalwarp`:
   
   To add alpha channel to a 3 band raster type in:
   ```
   gdalwarp -srcnodata "255 255 255" -dstalpha C:\your_raster.tif C:\your_raster_alpha.tif
   ```
   **Note:** "255 255 255" refers to the values in each R, G, B layer that is a no-data value (appears as white in the original tiff). If the area that needed to be transparent was black, this would be "0 0 0" instead.
   
   As a result you should see something like this:
   ```
   Creating output file that is 3931P x 3762L. Processing input file C:\rasters\ming.tif. 0...10...20...30...40...50...60...70...80...90...100 - done.
   ```
This will create the alpha channel (4th band) and add transparency to your raster image areas that are white; thus, your new raster_alpha.tif file is ready for upload to WorldMap. **Note:** this method does not allow retaining legends for your map as there is no style SLD file attached to it. This makes sense for those types of images which don’t need data derived legends such as satellite imagery, and various types of scanned paper maps.

b. If you have a single band grey scale raster with 8 bit pixels, your gdalinfo output with no color table should look like this:

```
Band 1 Block=128x128 Type=Byte, ColorInterp=Gray
Minimum=0.000, Maximum=8.000, Mean=0.034, StdDev=0.356
Metadata:
  STATISTICS_MINIMUM=0
  STATISTICS_MAXIMUM=8
```

Note: ColorInterp = Grey and there is no color table

In this case you can simply import your raster image into the Atlas Styler and create the SLD style with transparency in the styles window. Follow the steps below:

- Open the AtlasStyler and import your raster
- Right click on your raster and go to “styles”
- Click on “add new” on the left hand side and chose either “Explicit color per value” or “Colors for Value Ranges” style option
- Select the color scheme and add all values/classes
- Change opacity of selected cell values to ‘0’ (e.g. in the image below white areas of the raster are defined to be 100% transparent)

You can also add labels for your legends here. After you finish defining the colors, opacity and labels, confirm your changes and save your file as an SLD style file. You can now upload your raster image and the SLD style file on the WorldMap.
Note: this method does allow retaining legends in the style SLD file attached to it; you are uploading raster image together with the style SLD file created with AtlasStyler to the WorldMap environment. However, once you upload it to the WorldMap, you cannot edit your styles and/or legends. Not being able to edit raster legends is a bug.

c. If you have a single band raster with a built in color map, your gdalinfo output window should look like this:

```
Band 1 Block=128x128 Type=Byte, ColorInterp=Palette
Min=1.000 Max=163.000
NoData Value=0
Metadata:
  STATISTICS_MINIMUM=1
  STATISTICS_MAXIMUM=163
  STATISTICS_MEAN=10.726
  STATISTICS_STDDEV=18.098
Color Table <RGB with 256 entries>:
  0: 0,0,0,255
  1: 255,255,128,255
  2: 253,255,128,255
  3: 251,255,128,255
  4: 249,255,122,255
  5: 241,252,110,255
```

Note: ColorInterp = Palette and Color Table has RGB values defined

In this case, you can import your color map into the AtlasStyler and define opacity for the selected areas in your image by following the steps below:

- Open the AtlasStyler and import your raster
- Right click on your raster and go to “styles”
- In the styles window click on gdal button and copy paste the gdalinfo output including the color table with RGB values into this window, then click ok
- The color map classes will show up in the style window where you can change the opacity for selected cell values to ‘0’ as well as define labels for your legends
- Confirm the changes and save your raster & SLD, then upload it to the WorldMap environment

Note: this method does allow retaining legends in the style SLD file attached to it; you are uploading the raster image together with the style SLD file created in the AtlasStyler to the WorldMap environment. However, once you upload it to the WorldMap, you cannot edit your styles and/or legends. Not being able to edit raster styles is a bug.

d. If you have a single band raster with 24 bit pixels, the steps described in sections 3a, 3b, 3c will not work. You will first need to convert your raster data into a 3 band 8 bit pixel image.

You can do that using the open source pct2rgb.py gdal utility:

```
pct2rgb.py your_original.tif your_new_3band.tif
```

Once you convert your raster image, you can follow the steps in section 3.a to add transparency to selected areas on your image. You can read more about gdal utilities at [http://www.gdal.org/gdal_utilities.html](http://www.gdal.org/gdal_utilities.html)
Alternatively, you can use GIS software packages such as ArcGIS 10 to reformat your 3 band raster into a single band raster image. To convert your image into an 8 bit pixel single band raster in ArcGIS 10 simply copy or export your raster data with the following properties defined:

![Export Raster Data - Nsong_density](image)

**Important:** make sure to check the “Use renderer” option for the pixel depth 8 bit to take place.

After you convert your image to single band 8 bit pixel raster file, first make sure that your new 8 bit raster is saved as GeoTIFF (use `gdalinfo` utility described in step2). Then you can follow the steps described in section 3.b. **Note:** if your image is saved as TIFF and NOT as GeoTIFF, you will first need to convert it to GeoTIFF in order to follow this tutorial. There are a number of commercial software packages available for this task, e.g. GlobalMapper or FME. If you have problems with converting your raster file to GeoTIFF, please contact CGA at `contact@help.cga.harvard.edu` and one of our GIS professionals will be available to help you.

4. Final step is to add your new raster file to the WorldMap and check it for transparency.

**Summary notes:**
- It is important to understand the type of raster GeoTIFF image you have. Use `gdalinfo` utility described in step 2 and study the gdalinfo output results first.
- If you have a 3 band raster image, you will need to create an alpha channel to add transparency to selected areas in your image (see section 3.a for details).
- If you have a single band 8 bit pixel raster (with a grey scale), the easiest method is using Atlas Styler open source software package to add styles and transparency to your raster image (see section 3.b for grey scale details).
If you have a single band 8 bit pixel raster (with a built in color map), you can use Atlas Styler open source software package to import the color map styles and add transparency to selected areas in your raster image (see section 3.c for color map details).

If you have a single band 24 bit pixel raster, you will first need to convert your image to one of the formats mentioned above, and then add transparency (see section 3.d for details).

6.0 Curation – Registering Your Views on Map or Layer Quality

There are a number of ways to curate the maps and layers in WorldMap.

6.1 Certification

Note: Certification will be enabled on a case by case basis. Contact us if you would like Certification turned on for a user.

Once certification has been enabled for you, if you go to any layer page or map information page, on the right hand side there will be a "Certifications" section, just below the "Layer Styles" or "Map Views" section. This will display a list of links to users who have certified the map/layer, as well as a link to certify (or uncertify) it yourself (assuming you are logged in, and it is not a map/layer you own).

If you go to a profile page of a user who has certified anything, there will be a list of certified layers/maps at the bottom of the page.

6.2 Annotate a Map (Notes)

WorldMap supports the creation of annotation in the form of point, line, or polygon for "marking up" a map with comments. Comments are public can be responded to by others. Notes are turned off by default when a user opens a map.

6.3 Ranking and Commenting

Any Layer or Map may be commented on and ranked by anyone. Just go the Layer page or Map page for the Layer or Map you want to comment on. The Layer page may be accessed from the Map it is on by right clicking on the Layer and selecting “Share Layer”. Commenting and ranking capabilities are at the bottom left corner of the page.
To access the Map page for a Map, in the upper right corner of the Map, click “Share Map”. Again, commenting and ranking is at the bottom left of the page.
7.0 Appendices

7.1 Gazetteer API

There is a RESTful API to the above described gazetteer which makes it possible for remote applications to use the WorldMap gazetteer.

Matching items and their attributes are returned in JSON format (add "/xml" at the end of the URL to get it in XML format). Below is the specification for making gazetteer requests:

To retrieve a specific feature by numerid id:

- \text{http://worldmap.harvard.edu/gazetteer/\langle feature_id \rangle}
  - Example: \text{http://worldmap.harvard.edu/gazetteer/3867}

All other URL's begin with \text{http://worldmap.harvard.edu/gazetteer/\langle search_term \rangle} followed by any or all or none of the following:

- /Service/\langle services \rangle (Possible values include any/all of google, yahoo, geonames)
  - Example: Example: \text{http://worldmap.harvard.edu/gazetteer/Buena/Services/google,yahoo}

- /Project/\langle project_name \rangle (Only return results affiliated with a particular project name)
  - Example: \text{http://worldmap.harvard.edu/gazetteer/An/Project/CHGIS}

- /Map/\langle map_id \rangle (Only return results from layers on a specific map)
  - Example: \text{http://worldmap.harvard.edu/gazetteer/An/Map/79}

- /Layer/\langle layer_typename \rangle (Only return results from a specific layer)
  - Example: \text{http://worldmap.harvard.edu/gazetteer/Bu/Layer/windfarms_upf}

- /StartDate/\langle date \rangle (Only return results with a start date <= specified date (or null) and end date => start date (or null))
  - Examples:
    - \text{http://worldmap.harvard.edu/gazetteer/Xiangwu%20Xian/StartDate/500-01-01}
    - \text{http://worldmap.harvard.edu/gazetteer/Xiangwu%20Xian/StartDate/500%20AD}
    - \text{http://worldmap.harvard.edu/gazetteer/Xiangwu%20Xian/StartDate/100-01-01%20BC}

- /EndDate/\langle date \rangle (Only return results with a start date <= specified date (or null) and end date <= start date (or null))
  - Examples:
    - \text{http://worldmap.harvard.edu/gazetteer/Xiangwu%20Xian/EndDate/760%20AD}
    - \text{http://worldmap.harvard.edu/gazetteer/Xiangwu%20Xian/EndDate/765%20AD}
Example combination:

http://worldmap.harvard.edu/gazetteer/Xiangwu%20Xian//Service/google/Map/79/StartDate/10%20BC/EndDate/1

Any combinations must be in this order: /Service/Project/Map/Layer/StartDate/EndDate

7.1 Accessing OGC services without GetCapabilities
WorldMap has getcapabilities turned off for performance reasons, but if your client supports getmap you can still bring layer services into your remote map client.

The bare minimum you need to make a GetMap request with OpenLayers (and probably most other mapping API's):

- Layer typename: on the layer detail page, everything after the "/data/" part of the URL, for example:
  - geonode:POLICESTATIONS_PT_MEMA
- Geoserver URL's:
  - WMS: http://worldmap.harvard.edu/geoserver/wms
  - WFS: http://worldmap.harvard.edu/geoserver/wfs

You must include "TILED=true" in your GetMap requests.

If you are trying to access services via a pre-existing online/desktop application using WMS/WFS, there's a good chance that the app will try to make a GetCapabilities request when connecting, so the above information won't work.

If your client, such as most browser-based javascript mapping clients, can handle just loading a getmap request you are all set. See below:

Sample Javascript for adding a worldmap layer to an OpenLayers client

    new4 = new OpenLayers.Layer.WMS("MA Police Stations [WorldMap]",
       {LAYERS: "geonode:POLICESTATIONS_PT_MEMA", transparent: "true", tiled: "true"});
    map.addLayer(new4);

- or -

    new5 = new OpenLayers.Layer.WMS("CA County Data [WorldMap]",
       {LAYERS: "geonode:county_Bvu", transparent: "true", tiled: "true"});
    map.addLayer(new5);
7.2 Some WMS and ESRI REST Web Map Services that work in WorldMap

See Section 4.2 above for details on how to add a WMS or ArcGIS Rest service to your map.

The WMS and EsriREST Service URLs below can be used to bring thousands of valuable layers your your WorldMap Map from remote servers (without needing to download them!). The CGA is currently at work on a project to provide an easier way to access these and other service layers from within WorldMap.

To determine whether a service is WMS or REST, look at the URL. If there is no indication, it is most likely WMS.

**ESRI Global Satellite Service**
This is a great alternative to Google’s satellite if you need it. Load this as an ESRI Rest Service. The “World Imagery” layer has all the high resolution imagery included via scale dependency.

http://services.arcgisonline.com/ArcGIS/rest/services/World_Imagery/MapServer

**MassGIS – Massachusetts GIS**

http://giswebservices.massgis.state.ma.us/geoserver/wms

**Harvard AfricaMap Server** (cached).
These layers are not well named or documented yet (we are working on that), but there are many valuable layers here you won’t find anywhere else.

http://cga-5.hmdc.harvard.edu/tilecache/tiles.py/1.0.0/

**New York Public Library Map Rectifier** (cached)
Thousands of cached maps can be found from the NYPL collection and added to WorldMap by searching NYPL Site http://maps.nypl.org/warper using a web browser.
Go to the rectified map you want, click Edit/Rectify, Select Export Tab, copy “Tiles base URL” to WorldMap

**Cubewerx**

http://demo.cubewerx.com/demo/cubeserv/cubeserv.cgi?SERVICE=wms&VERSION=1.1.0&REQUEST=GetCapabilities

**NEXRAD Weather**

http://mesonet.agron.iastate.edu/cgi-bin/wms/nexrad/n0r.cgi

**Australia’s Tropical Land and Seas**


Some more…
ABI Quarterly and Annual Bankruptcy Filings
   http://maps1.arcgisonline.com/ArcGIS/rest/services/ABI_Quarterly_Bankruptcy_Filings_by_State/MapServer/

Automatic Traffic Recorder Stations
   http://maps1.arcgisonline.com/ArcGIS/rest/services/FHWA_Traffic_Stations/MapServer/

Biomass

Canadian Mineral Deposits
   http://apps1.gdr.nrcan.gc.ca/cgi-bin/canmin_en-ca_ows

CGKN WMS Layers
   http://cgkn2.cgkn.net/cgi-bin/cgknwms

Coalbed Methane Field Boundaries 2007

Critical Habitat
   http://maps1.arcgisonline.com/ArcGIS/rest/services/USFWS_Critical_Habitat/MapServer/

Development Risk
   http://maps1.arcgisonline.com/ArcGIS/rest/services/NREL_Development_Risk/MapServer/

Facilities Regulated by EPA
   http://maps1.arcgisonline.com/ArcGIS/rest/services/EPA_Facilities/MapServer/

Forest Fragmentation Risk
   http://maps1.arcgisonline.com/ArcGIS/rest/services/USGS_Forest_Fragmentation/MapServer/

FWS_Wetlands_WMS
   http://wetlandsfws.usgs.gov/ArcGIS/services/FWS_Wetlands_WMS/MapServer/WMSServer

Geodetic Control Stations
   http://maps1.arcgisonline.com/ArcGIS/rest/services/NGS_Geodetic_Control/MapServer/

GeoServer Web Map Service
   http://geoserver01.uit.tufts.edu/wms

Harvard Geospatial Library
   http://hgl.harvard.edu/cgi-bin/TileCache/tilecache.cgi

Hazardous Material Routes
   http://maps1.arcgisonline.com/ArcGIS/rest/services/FMCSA_Hazardous_Material_Routes/MapServer/

Insect and Disease Risk
   http://maps1.arcgisonline.com/ArcGIS/rest/services/FHTET_Insect_and_Disease_Risk/MapServer/

INSPIRE-PT Catalog Service
   http://cgpr.igeo.pt/catalogo-inspire-pt/services/csw
Landslides Incidence and Susceptibility
http://maps1.arcgisonline.com/ArcGIS/rest/services/USGS_Landslides/MapServer/

Layers
Layers
http://certmapper.cr.usgs.gov/arcgis/rest/services/applications/npra_seismic/MapServer/
Layers
Layers
http://certmapper.cr.usgs.gov/arcgis/rest/services/applications/npra_seismic_wells/MapServer/
Layers
http://certmapper.cr.usgs.gov/arcgis/rest/services/applications/oilshale_status/MapServer/
Layers
http://certmapper.cr.usgs.gov/arcgis/rest/services/applications/prov58geology/MapServer/
Layers
http://certmapper.cr.usgs.gov/arcgis/rest/services/applications/wyoming_wells_2010_mercator/MapServer/

London Borough of Tower Hamlets on Demand WMS
http://gis.towerhamlets.gov.uk/gisservices/services/WMS/INSPIRE/MapServer/WMServer

Massachusetts Data from MassGIS (GeoServer)
http://giswebservices.massgis.state.ma.us/geoserver/wms

OSM-WMS Uni Heidelberg
http://129.206.228.72/cached/osm/service

Survey Control Points
http://maps1.arcgisonline.com/ArcGIS/rest/services/NGS_Survey_Control_Points/MapServer/

US Historical Tornadoes
http://maps1.arcgisonline.com/ArcGIS/rest/services/NOAA_US_Historical_Tornadoes/MapServer/

US National Grid

USDA FHTET Wildland Urban Interface (WUI)
http://maps1.arcgisonline.com/ArcGIS/rest/services/FHTET_Wildland_Urban_Interface/MapServer/

USDA RMRS Wildland Fire Potential
http://maps1.arcgisonline.com/ArcGIS/rest/services/RMRS_Wildland_Fire_Potential/MapServer/

USDOC NOAA Weather Stations
http://maps1.arcgisonline.com/ArcGIS/rest/services/NWS_Weather_Stations/MapServer/
USDOT FHWA Automatic Traffic Recorder Stations
http://maps1.arcgisonline.com/ArcGIS/rest/services/USDOT_FHWA_Automatic_Traffic_Recorder_Stations/MapServer/

USDOT FRA Amtrak Stations
http://maps1.arcgisonline.com/ArcGIS/rest/services/FRA_Amtrak_Stations/MapServer/

USFS Ecological Subregions
http://maps1.arcgisonline.com/ArcGIS/rest/services/USFS_Ecological_Subregion/MapServer/

USGS Earthquake Faults
http://maps1.arcgisonline.com/ArcGIS/rest/services/USGS_Earthquake_Faults/MapServer/

Web Map Service atlanticcoast

WI_Consolidated_Geodetic_Control http://maps.sco.wisc.edu/cgi-bin/scowms.ctl

Woody Biomass http://maps1.arcgisonline.com/ArcGIS/rest/services/FIA_Woody_Biomass/MapServer/

### 7.3 Some GeoRSS Feeds to Try

USGS Earthquakes
http://earthquake.usgs.gov/earthquakes/catalogs/eqs7day-M2.5.xml

National Snow and Ice Center
http://nsidc.org/data/atlas/atlas_rss_feed.xml

Reuters news run through Geonames to geocode

### 7.4 Software

Styling software no longer being listed here because new automated classification capabilities have been added within WorldMap in the styling tool. See Section 5.3 (Classify Tool) above.

Desktop tool for converting Excel, GPS, or Google Earth files to Shape for uploading to WorldMap: Minnesota DNR Garmin
QGIS – Full featured Open Source GIS, great for creating the shape files WorldMap likes
http://www.qgis.org